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Cable multiconector 
de Duet

Manual del usuario 
de Duet

CD software Apogee

Cable FireWire de 1 m

Contenido del embalaje

Duet

Los artículos siguientes deben estar incluidos en 
el embalaje de Duet: 

Duet•	
Cable FireWire de 1 m•	
Cable multiconector de Duet•	
CD software Apogee•	
Manual del usuario de Duet•	
2 conectores mono 1/4” para  •	
adaptadores hembra RCA 
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Presentación de Duet

Nivel de entrada y salida
 Estos LED muestran 

el nivel de la entrada o salida 
seleccionada con el botón de 

selección.
 

Puerto FireWire
Utilice el cable FireWire 
para conectar su Mac aquí 
– Duet se alimenta a través 
de la conexión FireWire.

El botón de selección 
(Encoder)

El ajuste de los niveles es 
sumamente sencillo. Pulse el 

botón para seleccionar el nivel 
de entrada o salida que desee 

ajustar y gírelo hasta obtener el 
nivel deseado.

Cable multiconector E/S
Utilice el cable multiconector 
incluido para conectar 
micrófonos, instrumentos y 
salidas de línea aquí.

Salida de auriculares 
Conecte sus auriculares aquí.

Alimentación phantom
Estos LED indican que la 
alimentación phantom de 
48 V está activada en las 
conexiones   .
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Guía de inicio rápido

Requisitos del sistema

Mac G4 1GHz o superior, PPC o Intel CPU, 1 GB RAM mínimo, 2 GB recomendado,
OS X : 10.4.11 o superior instalado, 10.5.3 o superior muy recomendado.

Paquete de instalación del software 
Apogee
Introduzca el CD en su Mac, pulse dos 
veces sobre el icono del "Duet Software 
Installer" y siga las instrucciones de la 
pantalla.	Una	vez	finalizada	la	instalación,	
debe reiniciar el sistema.

   

Conexión del cable FireWire
Tras reiniciar el Mac, conecte el 
puerto FireWire de Duet con el puerto 
FireWire 400 del Mac usando el cable 
suministrado. 

Si su Mac sólo dispone de puertos 
Firewire 800, conecte Duet usando un 
cable FW400/FW800. Tenga en cuenta 
que, en este caso, el puerto FW800 
operará a la velocidad de un FW400. 

Debido a que Duet se alimenta a través 
de la conexión FireWire, el LED OUT 
debería iluminarse de inmediato.

2
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Guía de inicio rápido

Selección de Duet para Mac  
Sound I/O 
Después de conectar Duet a 
su Mac, aparecerá la caja de 
diálogo de la izquierda. Pulse 
Yes para seleccionar Duet como 
dispositivo de entrada/salida de 
sonido del Mac.

Esta selección también puede 
efectuarse en el panel System 
Preferences > Sound > Output.
  

            
Conexión de auriculares
Conecte un par de auriculares 
a la salida de auriculares 
de Duet, abra iTunes y 
comience la reproducción 
de una selección de audio. 
La reproducción debe ser 
audible a través de los 
auriculares conectados; el nivel 
de reproducción se muestra 
en los indicadores del panel 
superior de Duet. 

4
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Guía de inicio rápido

Uso de Duet con GarageBand 
                4.0.0 o superior recomendado
 

En GarageBand, seleccione GarageBand >
Preferences, pulse sobre el icono Audio/Midi y 
ajuste Audio Output y Audio Input a Duet.
Pulse sobre el icono Advanced y ajuste Audio 
Resolution a Better o Best.

Seleccione Track > New Basic Track...

Pulse dos veces sobre el cabezal de la pista 
para visualizar el panel Track Info; en este 
panel, ajuste Input Source a Mono 1 (Duet); 
ajuste Monitor a On.

 Para abrir el panel de control Apogee Duet en 
GarageBand, pulse sobre el botón Edit  
situado junto al menú Input Source.

Conecte el cable multiconector 
suministrado a la E/S de Duet y conecte 
un micrófono en el conector    IN-1 
XLR.

 

Pulse el centro del 
botón frontal hasta que 
el LED IN-1 se ilumine; 
gire el botón hasta que 
obtenga el nivel de 
grabación adecuado en 
la pista habilitada para la 
grabación.

Y ahora ya puede empezar a grabar...

5
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Guía de inicio rápido

Uso de Duet con Logic Pro/Express
 8.0.2 o superior recomendado

 
En el menú Logic Pro, seleccione  

 Preferences > Audio. Pulse sobre la 
pestaña Device y seleccione Core Audio.

 

 En el panel Core Audio, seleccione Duet 
en el menú Device. Seleccione 128 en el 
menú I/O Buffer Size. 

 Seleccione Audio > I/O Labels en el 
menú Options. Pulse opción-clic sobre el 
primer botón radio de la columna Driver’s 
I/O Labels. Las etiquetas de la unidad 
Duet aparecerán en las selecciones de 
entrada y salida de su sesión de Logic.

  

 Para controlar Duet directamente desde su 
sesión de Logic, seleccione Audio > Open 
Apogee Control Panel en el menú Options.

 Si está usando otra aplicación de audio 
compatible con Core Audio, use el 
software Maestro de Apogee (se instaló 
en la carpeta Applications durante la 
Fase 1) para controlar Duet.

6
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Funcionamiento

Los ajustes de Duet pueden ser editados fácilmente usando el botón de selección del 
panel frontal o los paneles de control descritos en la página 10. Aunque hay varias 
opciones disponibles, puede elegir los controles hardware y software que mejor se adapten 
a sus necesidades. Por ejemplo, los usuarios de Logic Pro pueden ajustar niveles con el 
encoder del panel frontal de Duet y cambiar los ajustes estáticos (como la fase o selección 
de entrada) desde el Apogee Control Panel incluido en Logic Pro 8. Para más comodidad, 
muchos de los ajustes pueden ser controlados desde varios paneles de control. La tabla 
de	la	página	9	indica	los	ajustes	y	funciones	que	pueden	modificarse	desde	cada	panel	de	
control.

Botón de selección del panel frontal de Duet (encoder)
El encoder del panel frontal de Duet proporciona un control simple e inmediato sobre los 
ajustes de nivel de entrada/salida. 
 Nivel de salida

Para cambiar el nivel de salida de Duet (es decir, el nivel de escucha de los 
auriculares y altavoces conectados), pulse y suelte el encoder varias veces 
hasta que el LED OUT se ilumine. A continuación, gire el encoder hasta el nivel 
de escucha deseado. El encoder de la unidad funciona paralelamente a los 
controles de nivel del software.

 Nivel de entrada
 Para cambiar el nivel de entrada de Duet (es decir, el nivel de grabación de  
 micrófonos e instrumentos), pulse y suelte el encoder varias veces hasta que  
 el IN-1 o IN-2 se ilumine.  
 A continuación, gire el encoder hasta alcanzar el nivel de grabación deseado 
 (como haría en el software de grabación).
 Salidas desactivadas

Para silenciar las salidas de línea y auriculares simultáneamente, pulse y 
mantenga pulsado el encoder hasta que el LED OUT parpadee; pulse y vuelva a 
mantener pulsado el botón para desactivar el silencio.

 Controlador MIDI
El encoder también puede enviar datos de Controlador MIDI y de Posición 
de canción a las aplicaciones de audio. Consulte las páginas 16-17 para más 
detalles.
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Funcionamiento

Duet 
Hardware 
Encoder  

Apogee 
Maestro

Apogee 
Control 
Panel 

(en Logic)

Panel 
Apogee 
Duet en 
Garage-

Band

Configura-
ción Audio 

MIDI

Pref. del 
sistema

Ganancia de entrada

Control de entrada - 
Selección, 48v, Grupo, 
Fase

Control de salida -  
Atenuación, Mute

Control de salida - 
Nominal Level

Mezclador de baja 
latencia

Funciones avanzadas
                 *

Controlador MIDI

Frecuencia de 
muestreo (véase p.10)

Asignar Duet como 
Entrada/Salida para 
OSX

* Todo excepto Gain Mode
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Funcionamiento

Apogee Maestro
El software Apogee Maestro proporciona el control más completo de Duet, incluyendo el 
control de todos los parámetros de la interfaz, el almacenamiento/recuperación de ajustes 
y la mezcla de baja latencia. Si su software de grabación no incluye un panel de control 
Apogee, utilice Apogee Maestro para efectuar los ajustes.

Mezclador de baja latencia de Maestro
En algunos casos, durante la grabación, puede producirse un retardo entre el momento 
en que interpreta o canta una nota y el momento en que la escucha a través de sus 
auriculares; el mezclador de baja latencia de Maestro puede resolver este problema. 
Consulte las páginas 18-21 para más detalles acerca del mezclador de baja latencia.  

Para una explicación más detallada sobre Maestro, consulte las páginas 12-26.

Apogee Control Panel (Logic Pro 8, GarageBand)
El Apogee Control Panel, que encontrará dentro de Logic Pro 8 y Garage Band, permite 
controlar todos los parámetros de Duet y el almacenamiento/recuperación de ajustes. Los 
paneles de control de estos programas duplican todos los ajustes encontrados en el panel 
Control Maestro.

Preferencias del sistema OS X
La ventana System Preferences Sound de OSX proporciona los ajustes necesarios 
para seleccionar Duet como dispositivo de entrada y salida de sonido del Mac. Si no ha 
seleccionado Duet como dispositivo de entrada y salida de sonido del Mac en el paso 3 de la 
guía de inicio rápida, puede hacerlo desde esta ventana. 
 Seleccione menú Apple > System Preferences;
 Abra la ventana de preferencias del sonido pulsando sobre el icono de altavoz;
 Pulse sobre la pestaña Output y seleccione Duet en la ventana Device;
 Pulse sobre la pestaña Input y seleccione Duet en la ventana Device.

Configuración Audio MIDI OS X
La	configuración	Audio	Midi	OS	X	(AMS)	(ubicada	en	la	carpeta	Aplicaciones/Utilidades)	
controla la frecuencia de muestreo y el nivel de salida de Duet, así como los ajustes 
para seleccionar Duet como dispositivo para la entrada y salida de sonido del Mac. Para 
controlar el nivel de salida de Duet y la desactivación de sonido desde AMS o desde el 
teclado del  Mac, ajuste Default Output a Duet.

Ajuste de la frecuencia de muestreo
Duet funciona en todo el rango de frecuencias estándar (44.1k - 96k).  
La	frecuencia	de	muestreo	viene	definida,	en	la	mayoría	de	los	casos,	por	la	
aplicación de audio con la que Duet se está comunicando. Por ejemplo, si 
utiliza Duet con GarageBand, la frecuencia de muestreo de Duet se ajustará 
automáticamente a 44.1k para concordar con la frecuencia de muestreo de la 
canción en GarageBand. En las aplicaciones de audio que no incluyan el ajuste 
de la frecuencia de muestreo, como iTunes, el ajuste en Duet se efectuará a 
través de la opción AMS.
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Apogee Maestro

Preferencias del sistema OS X

Apogee Control Panel

Configuración Audio MIDI OS X
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Control Maestro – Niveles

Menú Interface
Cuando Duet es detectada por Maestro, tanto Duet como el número de serie de la 
unidad aparecen en este menú.

Identify Unit
Si	pulsa	sobre	este	botón,	podrá	verificar	la	conexión	entre	el	software	Maestro	y	el	
hardware Duet (se iluminarán los LED del panel frontal).  Pulse de nuevo sobre el 
botón para que los LED del Duet recobren su función normal.
 
Input 
Este menú se utiliza para seleccionar el nivel y el conector de entrada:

XLR Line +4dBu – Ajuste Input a XLR Line +4dBu en el caso de tener 
conectada una entrada de línea profesional (por ejemplo, una consola de 
mezclas profesional) a los conectores  IN (XLR).
XLR Line –10 dBV – Ajuste Input a XLR Line -10dBV en el caso de 
tener conectada una entrada de línea de nivel consumidor (por ejemplo, 
un lector de CD) a los conectores  IN (XLR).
XLR Mic – Ajuste Input a XLR Mic en el caso de tener conectado un 
micrófono a los conectores  IN (XLR). La ganancia es regulable entre 
10 y 75 dB.
Instrument – Ajuste Input a Instrument en el caso de tener conectada 
una guitarra o teclado a los conectores  IN (1/4”); la ganancia es 
regulable entre 0 y 65 dB. También es posible conectar lectores CD y 
otros dispositivos similares  (-10 dBV) a estas entradas.

Cuando Input está ajustado a XLR Mic o Instrument, los controles siguientes 
están disponibles:

Group – Seleccione alguna de estas casillas para agrupar los ajustes 
de ganancia de ambas entradas de manera que el encoder de la unidad 
o uno de los controles del software regulen las ganancias de las dos 
entradas al mismo tiempo. Si al seleccionar Group existe un desfase de 
ganancia entre las entradas, tal desfase se mantendrá. 
Botón software del nivel de entrada – Este control del software permite 
regular la ganancia de cada entrada. El nivel de ganancia se muestra en 
la casilla situada a la derecha del control.
Icono de fase – La selección de esta casilla invierte la polaridad de la 
señal de entrada. Bajo determinadas circunstancias, cuando se utilizan 
dos micrófonos con una misma fuente, la inversión de polaridad de uno 
de los micros puede enriquecer la calidad del sonido. Por ejemplo, si 
coloca varios micros debajo de una caja de batería, obtendrá un sonido 
más potente al invertir la polaridad del micrófono inferior.
48V – Seleccione esta casilla para aplicar la alimentación phantom 
de 48 voltios en las conexiones XLR. Los micrófonos de condensador 
requieren alimentación phantom para funcionar. 

Maestro

1

2

3

4

5
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Level 
Este menú permite ajustar el nivel nominal o medio de las salidas de línea:

Line out – Ajuste Level a Line out cuando conecte los conectores 
OUT-L  o OUT-R	de	Duet	a	unos	monitores	activos,	un	sistema	hi-fi	o	
una consola de mezclas.
Instrument Amp – Ajuste Level a Instrument Amp cuando conecte los 
conectores OUT-L  o OUT-R de Duet a una entrada amp de instrumento. 
El	nivel	de	salida	es	fijo.

Botón software del nivel de salida
Este control del software permite regular simultáneamente el nivel de la salida 
de línea y la de auriculares cuando Level está ajustado a Line out. El nivel de 
atenuación se muestra en la casilla situada a la derecha del control.
 
Mute 
Al seleccionar esta casilla se silencian las salidas de línea y de auriculares 
simultáneamente.

7

8
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Control Maestro – Avanzado

OUT Muting – Estas casillas determinan las salidas que hay que silenciar cuando 
la función Mute está activada. He aquí algunos ejemplos:

Cuando se seleccionan las casillas tal y como se 
muestra en la imagen de la izquierda, es  posible alternar 
entre un modo de grabación (auriculares activados, 
monitores conectados a la salida de línea desactivados) 
y un modo de reproducción (auriculares desactivados, 
monitores activados) con una sola acción – activar y 
desactivar la opción Mute.  Como el control de volumen 
de las dos salidas es compartido, es una buena idea 
comprobar el nivel antes de desactivar la opción Mute en 
las salidas de línea.

Cuando se seleccionan las casillas tal y como se 
muestra en la imagen de la izquierda, las salidas de 
auriculares no se silencian jamás; cuando Mute está 
activado, sólo se silencian las salidas de línea. 

Mic/Instrument gain mode – Este menú permite ajustar el modo de ganancia de 
entrada:

Max. Gain range – El rango de ganancia completo está disponible con 
un conmutador de relé tras los primeros 10 dB de ganancia. 
Clickless Operation – El rango de ganancia se reduce ligeramente pero 
no se emplea ningún relé; el resultado es un funcionamiento sin clic sea 
cual sea el ajuste de ganancia. Un rango de ganancia apropiado se basa 
en los ajustes Input y 48V.

Meters Display
Este menú selecciona la señal que debe mostrarse en los indicadores del panel 
frontal; las selecciones son Input, Output, o Follow Selection. Cuando se 
selecciona Follow Selection, el visor del indicador sigue al indicador del ajuste 
del panel frontal; por consiguiente, cuando se selecciona IN-1 o IN-2, el indicador 
muestra las dos entradas y cuando se selecciona OUT, el indicador muestra la 
salida estéreo. 
 
Over Hold
Cuando Over Hold es ajustado a Infinite, la indicación de picos (Over) permanece 
"activa" mientras no sea cancelada por el usuario. Para cancelar los picos, es 
necesario pulsar sobre el indicador de picos o sobre Clear Overs en el panel 
Maestro Mixer. Cuando Over Hold está ajustado a 2 segundos, la indicación de 
picos (Over) desaparece automáticamente después de dos segundos.

Maestro
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Control Maestro – Avanzado: Controladores MIDI

Number of MIDI Controllers – Para acceder a la función MIDI de Duet, cree de 1 
a 4 instancias de controlador MIDI virtuales mediante este contador. Una vez haya 
creado	la	instancia	de	1	o	más	controladores	MIDI,	podrá	modificarlos	con	el	botón	
del panel frontal o con el control correspondiente del software. Para seleccionar 
un controlador MIDI mediante el botón del panel frontal, pulse el botón hasta que 
el menú desplegable de Duet muestre la selección del controlador MIDI deseado 
(consulte la pág. 16 para más detalles sobre los menús desplegables de Duet). 
Cuando se seleccionan los controladores MIDI, no se ilumina ningún LED del panel 
frontal (IN-1, IN-2 ,OUT).

Cuando Number of MIDI Controllers es ajustado a 1 - 4, los siguientes ajustes 
están disponibles:

MIDI encoder – Este control del software se utiliza para enviar datos de 
Controlador MIDI y de Posición de canción a las aplicaciones de audio.

Cuando el menú de la función está ajustado a Controller, los siguientes ajustes 
están disponibles:

Number – Esta casilla muestra el número de controlador MIDI CC.   
Es posible introducir el rango completo de controles de 7 bits (0-127).
Chan – Esta casilla muestra el canal MIDI al que se envían los datos de 
controlador MIDI. El rango disponible es 1-16.
Value – Es posible introducir directamente los números del rango 0-127 
(seguidos por las teclas Enter o Return para aceptar el valor), si bien la  
rotación del botón ignorará la entrada numérica.

Cuando el menú de la función está ajustado a Song Position, los siguientes 
ajustes están disponibles:

1/4 Note	–	Esta	casilla	muestra	la	posición	actual	de	la	canción,	definida	
como el número de tiempos de nota de 1/4 desde el inicio de la canción 
(tiempo 0).

Maestro
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Maestro

Mezcla de baja latencia

Antes de explicar las funciones del panel Mixer de Maestro, vamos a describir unos 
cuantos	conceptos	básicos	sobre	la	latencia	y	las	configuraciones	de	grabación	digital	
basada en computadora que le ayudarán a entender mejor estas funciones.

Las grabaciones realizadas con muchas de las aplicaciones de audio digital suelen 
provocar un retardo entre la entrada y salida del sistema de grabación que perturba a 
los	músicos	durante	sus	interpretaciones.	Este	retardo,	conocido	como	latencia,	significa	
que el músico escucha las notas interpretadas unos milisegundos después de haberlas 
interpretado. Como cualquiera que haya tenido una conversación telefónica con eco ya 
sabe, los retardos relativamente cortos pueden alterar la sincronía de una conversación.

Para	ilustrar	el	efecto	de	la	latencia,	la	figura	A	muestra	la	ruta	típica	de	señal	de	una	
sesión de overdub vocal. Un vocalista canta a través de un micrófono: la señal es 
dirigida, en primer lugar, hacia un conversor analógico/digital y, en segundo lugar, hacia la 
aplicación de audio donde se producirá la grabación. En la aplicación de audio, la señal 
procedente del vocalista se mezcla con las pistas previamente grabadas (playback), y de 
ahí se encamina hacia un conversor digital/analógico antes de llegar a los auriculares del 
vocalista. Cada etapa de conversión acumula un ligero retardo, mientras que el retardo 
producido por el paso de la señal a través de la aplicación de audio es aún mayor. De ahí 
que el vocalista escuche su interpretación con un retardo de varios milisegundos.

Figura 1

Figura A

Interfaz  
hardware

Pista habilitada 
para la grabación

Salida de DAW

Latencia

Latencia Latencia

Latencia

Aplicación  
de audio
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Mezcla de baja latencia - continuación

Al dirigir la entrada del hardware directamente hasta la salida del hardware y mezclar el 
playback tal y como se indica en la Figura B, es posible proporcionar al vocalista una señal 
de monitorización a través de los auriculares con un retardo mucho menor. 

En primer lugar, la señal de grabación (en este caso, un micrófono vocal) se divide justo 
después de la conversión A/D: una parte se dirige hacia la aplicación de audio para su 
grabación, y la otra vuelve directamente hacia las salidas del hardware sin pasar por la 
aplicación (que es la mayor generadora de latencia); el resultado es una ruta de baja 
latencia desde el micro hasta los auriculares. A continuación, una mezcla estéreo de pistas 
de playback se dirige hacia el mezclador de baja latencia y se combina con la entrada(s) 
del hardware. De este modo, el intérprete puede escucharse a sí mismo sin apenas retardo 
al tiempo que escucha las pistas de playback para poder grabar los overdubs.

Tenga	en	cuenta	que	el	mezclador	de	la	aplicación	de	audio	se	utiliza	para	configurar	una	
mezcla estéreo de pistas de playback mientras que el mezclador de baja latencia se utiliza 
para crear un equilibrio entre la mezcla de playback estéreo y las entradas hardware.

Maestro

Figura 2

Figura B

Interfaz  
hardware

Mezclador de  
baja latencia

Pista habilitada 
para la grabación

Salida de DAW

Latencia

Latencia Latencia

Latencia

Aplicación  
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Maestro Mixer

El mezclador de Maestro (Maestro Mixer) permite combinar las entradas hardware de Duet 
con la reproducción de una aplicación de audio y dirigir la mezcla resultante a las salidas 
de la unidad. El mezclador de Maestro permite crear una mezcla de monitorización en 
donde la latencia no es un problema.

Input 1, Input 2 – Estos canales 
proporcionan las posibilidades 
de mezcla para dirigir y mezclar 
la señal de cada entrada de Duet 
directamente hasta las salidas de la 
unidad. La fuente de entrada viene 
determinada por el ajuste Input 
(Pág. 12).

From Mac  - Este canal proporciona 
las posibilidades de mezcla para 
combinar la salida de una aplicación 
de audio con las salidas hardware 
de Duet.  

To Hardware – Este canal 
proporciona el routing y el nivel de 
salida del mezclador. 
 
Cuando To Hardware está ajustado 
a Out L-R, la salida del mezclador 
se envía a las salidas hardware de 
Duet.

Cuando To Hardware está 
ajustado a None, el mezclador 
es deshabilitado y la salida de la 
aplicación de audio es enviada 
directamente a las salidas hardware 
de Duet, ignorando el Maestro 
Mixer. 

Maestro

1

2

3

1 2 3
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Trabajando con Maestro Mixer

¿Es necesario usar Maestro Mixer?
El mezclador de Maestro proporciona una mezcla de monitorización de baja latencia 
durante la grabación. Por lo tanto, si está usando Duet para escuchar el audio procedente 
de iTunes u otro programa similar, no es necesario usar el mezclador. Ajuste To Hardware 
a None para desactivar el mezclador.

Es posible que la latencia de su sistema de grabación sea lo bastante baja como para 
pasar desapercibida. La latencia del sistema está determinada por el ajuste de búfer del 
software	de	grabación:	si	el		Mac	es	lo	suficientemente	potente,	será	posible	ajustar	el	
búfer con un valor más bajo (menos latencia) sin que por ello se produzcan chasquidos y 
crujidos en la salida de audio. Si la latencia no es un problema durante la grabación, puede 
desactivar el mezclador ajustando To Hardware a None.

Ajustes del software de grabación
Antes de usar el mezclador de Maestro, es necesario cambiar unos ajustes en el software 
de grabación. 
Software monitoring - Dado que la señal de grabación es monitorizada a través 
del mezclador de Maestro, las salidas de las pistas con grabaciones activas deben 
ser desactivadas (ya que se trata de la mayor fuente de latencia). La mayor parte de 
aplicaciones de audio disponen de una opción que permite desactivar la monitorización 
de las pistas de grabación. En Logic Pro, por ejemplo, la opción de monitorización se 
encuentra en la misma ventana de preferencias de audio que la usada para seleccionar 
Duet como dispositivo hardware (Logic Pro > Preferences > Audio). Deshabilite la casilla 
Software Monitoring.
Playback mix	-	En	su	software	de	grabación,	configure	una	mezcla	de	todas	las	pistas	de	
reproducción y dirija la señal hacia Out L-R. Si un deslizador principal controla la salida 
global de la mezcla, recomendamos ajustar el deslizador a 0 dB. 

Ajustes de Maestro
Ajustes del mezclador de Maestro - Antes que nada, ajuste los deslizadores Input, From 
Mac y To Hardware a 0 dB. Ajuste el menú To Hardware a Out L-R. 
Después de hacer la selección de entrada y de ajustar la ganancia (tal y como se 
describe en la página 12), la señal debería mostrarse en los dos indicadores de Input y 
To Hardware. Si el LED Over de Input se ilumina, reduzca la ganancia de entrada en la 
ventana Maestro Control. Si el LED Over de To Hardware se ilumina, reduzca el deslizador 
de Input. 
Ahora reproduzca el playback de la sesión. La señal del playback debe aparecer en 
los indicadores de From Mac y To Hardware. Utilice los deslizadores From Mac e Input 
para crear un equilibrio entre las señales de entrada y reproducción. Si ha encontrado 
el equilibrio pero el LED Over de To Hardware se ilumina, reduzca el deslizador de To 
Hardware. 
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Maestro

Preferencias de Maestro – Preferencias de Duet

Las dos preferencias de Maestro relativas a Duet se describen a continuación. Para la 
descripción de otras preferencias, consulte la página 24.

Launch Maestro automatically when connecting a device (Inicio automático de 
Maestro tras la conexión de un dispositivo) 
Si selecciona esta casilla, Maestro se iniciará automáticamente tras detectar la unidad 
Duet en el bus FireWire del Mac. Para recuperar los ajustes del mezclador de Maestro tras 
el inicio del sistema, esta casilla debe estar seleccionada. De lo contrario, los ajustes del 
mezclador de Maestro se perderán tras cerrar o reiniciar el Mac.

Enable Duet pop-ups (Habilitar los menús desplegables de Duet)
Si selecciona esta casilla, los menús desplegables de los controles aparecen en el 
escritorio del Mac, el cual mostrará varios ajustes de Duet, como los niveles de entrada y 
salida, Input, Group y Mute. Para ilustrar lo anterior, he aquí algunos ejemplos:

IN-1 seleccionado,  
Input ajustado a  XLR Mic,  
control ajustado a 40 dB

IN-1 y IN-2 seleccionados,  
Group seleccionado,  
Input 1 ajustado a XLR Mic,  
Input 2 ajustado a Instrument,  
control 1 ajustado a 30 dB,  
control 2 ajustado a 40 dB.
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Maestro

OUT Nivel ajustado a –12 dB 
Mute activado 
OUT muting ajustado como sigue

Mute activado,  
OUT muting ajustado como sigue

Control	ajustado	para	modificar	el	Controlador	MIDI	1
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Maestro

Controles rotatorios
Mouse motion	–	Esta	selección	define	cómo	mover	el	ratón	para	ajustar	los	controles	
rotatorios.
Fine adjust key	–	Esta	selección	define	el	comando	de	teclado	necesario	para	
efectuar ajustes de precisión en cualquier control rotatorio. 

Controles de los deslizadores
Fine adjust key -	Esta	selección	define	el	comando	de	
teclado necesario para efectuar ajustes de precisión en 
cualquier deslizador.
0dB key	–	Esta	selección	define	el	comando	de	teclado	
necesario para ajustar el deslizador a 0 dB al pulsar en 
la ventana de valores de nivel.
Ungroup faders -	Esta	selección	define	el	comando	de	
teclado necesario para ajustar uno de los lados en los 
deslizadores estéreo From Mac y To Hardware.

Controles de pan
Fine adjust key	-	Esta	selección	define	el	comando	de	
teclado necesario para efectuar ajustes de precisión 
sobre cualquier control de panorama.
0dB key	–	Esta	selección	define	el	comando	de	teclado	
necesario para ajustar el panorama a <0> al pulsar en 
la ventana de valores de panorama.

Otros
Mute/Solo all	-	Esta	selección	define	el	comando	de	teclado	necesario	para	activar	
todos los Mute o Solo al pulsar los botones de Mute o Solo.

Preferencias adicionales
Launch Maestro automatically when connecting a device - Si selecciona esta 
casilla, Maestro se iniciará automáticamente tras detectar la unidad Duet.

Maestro > About Maestro
Si selecciona esta opción se 
abrirá la ventana de la derecha 
para mostrar varias versiones de 
firmware	y	software.	

Menú por menú

Maestro > Preferences
La	selección	de	esta	opción	abre	la	ventana	Preferences	en	donde	podrá	definir	la	acción	
de los controles.
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Maestro

Menú por menú

Maestro > Hide Maestro
La selección de esta opción oculta la aplicación Maestro.

Maestro > Hide Others 
La selección de esta opción oculta el resto de aplicaciones abiertas.

Maestro > Show All
Si Hide Others ha sido previamente seleccionada, la selección de esta opción mostrará 
todas las aplicaciones abiertas en el Finder.

Maestro > Quit Maestro 
La selección de esta opción cierra el programa Maestro.

Archivo:
File > Open
Seleccione	esta	opción	para	buscar	y	abrir	una	configuración	Maestro	previamente	
guardada.

File > Open Recent 
Seleccione	esta	opción	para	volver	a	abrir	una	configuración	Maestro	abierta	
recientemente.

File > Close Window 
Seleccione esta opción de para cerrar la ventana "activa".

File > Save 
Seleccione esta opción para guardar los ajustes actuales de todas las ventanas.

File > Save As
Seleccione esta opción para guardar los ajustes actuales de todas las ventanas con un 
nombre distinto.
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Maestro

Window:
Window > Minimize

La selección de esta opción minimiza la ventana abierta y la desplaza al dock de OS.
Window > Zoom

La selección de esta opción maximiza el tamaño de la ventana activa de Maestro
Window > Bring All to Front

La selección de esta opción coloca todas las ventanas de Maestro en primer plano.

Tools:
Tools > Maestro Control

La selección de esta opción abre la ventana Maestro Control.
Tools > Maestro Mixer

La selección de esta opción abre la ventana Routing/Mixer.
Tools > Reset Symphony Clocking

En determinados casos, las interfaces Apogee no son detectadas hasta que el ajuste 
de reloj de la primera interfaz haya sido restaurado. Si selecciona Choosing Reset 
Symphony Clocking, podrá restaurar la fuente de reloj de la primera interfaz a Internal o 
External.

Tools > Refresh Connections
La selección de esta opción re-escanea las conexiones de la computadora del 
dispositivo Apogee conectado.

Tools > Reset Mixer
Esta opción permite restaurar los mezcladores de Maestro; seleccione Reset Displayed 
para restaurar el mezclador que aparece en la ventana Maestro Mixer; seleccione Reset 
All para restaurar todos los mezcladores.

Tools > Reset Routing
Esta	opción	permite	restaurar	los	paneles	Input	y	Output	a	una	configuración	“pass	
through” en la que las E/S hardware y software están conectadas según el criterio una 
por una.

Menú por menú
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Conecte los monitores a las salidas 1/4” 

con los  iconos etiquetados como OUT-L 

y OUT-R en el cable multiconector.

Conecte sus auriculares a la 

salida 1/4” con el icono .

Conexiones de Duet 

Monitores y auriculares

Si las entradas de sus 

monitores o las entradas 

estéreo son del tipo RCA, 

utilice los adaptadores 

incluidos para 

establecer la conexión. 

Introduzca el adaptador 

en las conexiones 

OUT-L  y OUT-R del 

cable multiconector, 

y a continuación 

conecte el cable RCA.
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Conexiones de Duet 

Instrumento y micrófono

Conecte un instrumento en la 

entrada 1/4” con el  

icono    etiquetado como 

IN-1 en el cable multiconector.

Conecte un micrófono en la 

entrada XLR con el icono        

etiquetado como IN-2 en el 

cable multiconector.
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Conexiones de Duet 

Instrumento e instrumento

Conecte un instrumento en la 

entrada 1/4” con el  

icono   etiquetado como 

IN-1 en el cable multiconector.

Conecte un instrumento en la 

entrada 1/4” con el  

icono    etiquetado como 

IN-2 en el cable multiconector.
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Conexiones de Duet 

Micrófono y micrófono

Conecte un micrófono en la 

entrada XLR con el icono        

etiquetado como IN-2 en el cable 

multiconector.

Conecte un micrófono en la 

entrada XLR con el icono        
etiquetado como IN-1 en el cable 

multiconector.
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Conexiones de Duet

Conecte los monitores a las salidas 
1/4” con los iconos  etiquetados 
como OUT-L y OUT-R en el cable 
multiconector.

Monitores activos

Duet es también la mejor manera de escuchar el audio desde el Mac, bien sea desde una 
biblioteca iTunes, una emisora de radio en la red o la lectura de un CD/DVD.

Para conectar las salidas de línea de Duet directamente a unos monitores activos, son 
necesarios 2 cables de 1/4” en un extremo para conectar las tomas OUT-L  y OUT-R del 
Duet, y el conector adecuado en los demás extremos para conectar los monitores. Para 
más comodidad, el paquete Duet incluye 2 adaptadores 1/4” / RCA, permitiendo el uso de 
cables RCA/RCA tradicionales para la conexión del equipo estéreo doméstico.

Durante la conexión de monitores activos, utilice el botón de selección de Duet para regular 
el volumen de reproducción.
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Conexión con un equipo estéreo doméstico 

Para conectar Duet directamente a un equipo estéreo doméstico (home audio), introduzca los 
adaptadores 1/4”/RCA en las tomas OUT-L y OUT-R de Duet, y utilice un cable RCA/RCA para 
conectarlo a la entrada AUX o CD del receptor. 

Durante la conexión con un equipo estéreo doméstico, ajuste la salida de Duet a 0 dB (es 
decir, volumen máximo) y utilice el control de volumen del receptor para ajustar el nivel de 
reproducción.

Una vez establecidas las conexiones de audio, conecte el puerto FireWire de Duet al Mac. Una 
vez conectado, aparecerá la caja de diálogo que se muestra a continuación.  Pulse Yes para 
seleccionar Duet como dispositivo de entrada/salida de sonido del Mac.

Esta selección también puede efectuarse en el panel System Preferences > Sound > Output.

En iTunes, seleccione Computer como salida de audio. Todo el audio reproducido en iTunes 
será dirigido hacia Duet y la salida estará disponible en su equipo estéreo doméstico.
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Resolución de problemas

P: Cuando pulso el botón para seleccionar una entrada o una salida, la selección no está 
disponible. ¿Por qué? 

R: Cuando la entrada está ajustada a XLR line, o la salida a Instrument 
Amp, el botón de selección permanece desactivado y, por consiguiente, no es 
seleccionable.

P: Cuando pulso el botón para seleccionar una entrada o una salida, TODOS los LED se 
apagan. ¿Por qué? 

R: Cuando uno o más controladores MIDI son activados y seleccionados 
para el control por el botón del panel frontal, todos los LED de E/S del panel 
frontal se apagan para indicar la selección de un controlador MIDI. Si los menús 
desplegables están habilitados en las preferencias de Maestro, el controlador 
MIDI seleccionado se mostrará en la pantalla.

P: He conectado mi guitarra pero no percibo ninguna señal de entrada. ¿Qué debo 
comprobar?

R: En Maestro, ajuste Input a Instrument.

P: No estoy obteniendo ninguna salida de las aplicaciones de audio. ¿Qué debo 
comprobar?

R: Si el LED OUT parpadea quiere decir que la salida está silenciada. Pulse 
y mantenga pulsado el botón del panel frontal de la unidad hasta que el LED 
OUT deje de parpadear. Asimismo, si la salida del mezclador de Maestro está 
ajustada a Out L-R, debe elevar el deslizador From Mac para enviar las salidas 
de la aplicación de audio a las salidas de Duet.

P: Quiero que Maestro se abra automáticamente cuando conecte la unidad Duet. ¿Qué 
debo hacer?

R: Abra Maestro > Preferences y marque la casilla Launch Maestro 
automatically when connecting Duet.

P: ¿Puedo ajustar las salidas de línea y auriculares con niveles diferentes?

R: Las salidas de línea y auriculares son siempre controladas 
simultáneamente. Para ajustar el balance entre los auriculares y monitores 
conectados	a	las	salidas	de	línea,	ajuste	el	amplificador	de	los	monitores	en	
concordancia. Es posible silenciar las salidas de línea y de auriculares por 
separado.

P: ¿Cómo puedo restaurar los valores iniciales de Duet?

R: Para reiniciar Duet, pulse y mantenga pulsado el botón durante 5 segundos. 
Todos los ajustes volverán a sus valores predeterminados.
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Uso de Duet con Apple Soundtrack Pro

Seleccione Soundtrack Pro > Preferences.

Pulse sobre la pestaña Recording.
Seleccione Duet en los menús Input y Monitor.
Cierre la ventana Preferences tras haber efectuado 
los ajustes.

Uso de Duet con Apple MainStage

Seleccione MainStage > Preferences.

 

Pulse sobre la pestaña Audio/Midi.
Seleccione Duet en los menús Audio Output y Audio 
Input.
Ajuste I/O Buffer Size a 128
Cierre la ventana Preferences tras haber efectuado 
los ajustes.

Para controlar Duet directamente en una actuación 
en directo, seleccione Mainstage > Open Apogee 
Control Panel.

Guía de aplicaciones Core Audio
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Uso de Duet con Apple Final Cut Pro

Seleccione Final Cut Pro > Audio/Video Settings.

Pulse sobre la pestaña A/V Devices.
Seleccione Duet en el menú Audio.
Pulse OK.

 

Uso de Duet con Ableton Live

Seleccione Live > Preferences

Pulse sobre la pestaña Audio
Seleccione CoreAudio en el menú Driver Type
Seleccione Duet en los menús Audio Input Device y 
Audio Output Device.
Ajuste Buffer Size a 128.
Cierre la ventana Preferences tras haber efectuado 
los ajustes.

Guía de aplicaciones Core Audio
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Uso de Duet con MOTU Digital Performer

Seleccione	Setup	>	Configure	Audio	System	>	
Configure	Hardware	Driver.

En	la	ventana	Configure	Hardware	Driver,	seleccione	
CoreAudio en el menú superior.
Seleccione Duet en la lista de dispositivos.
Ajuste Buffer Size a 128.
Ajuste Host Buffer Multiplier a 1.
Ajuste Work Priority a Low.
Pulse OK.

  

Uso de Duet con Steinberg Nuendo

Seleccione Devices > Device Setup

En la ventana Devices, pulse sobre VST Audio 
System.
Seleccione Duet en el menú ASIO.

Cuando Duet haya sido reconocida por Nuendo, 
seleccione Duet en la ventana Devices.
Pulse sobre Control Panel
En el menú ASIO Settings, ajuste Buffer Size a 128 
y pulse OK.
En la ventana Device Setup, pulse OK.

Guía de aplicaciones Core Audio
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Características y especificaciones técnicas

Dos canales de entrada y salida audio a 24 bits/96 kHz y calidad profesional•	
Dos entradas XLR balanceadas, con alimentación phantom de 48 V seleccionable•	
Entrada máxima - ajuste +4 dBu: 20 dBu; ajuste -10 dBV: +8 dBV•	
Ganancia Mic Pre-amp: 10 - 75 dB•	
Dos entradas de instrumento de alta impedancia no balanceadas•	
Una salida de auriculares estéreo de alto nivel•	
Dos salidas de línea -10 dBV no balanceadas para los monitores activos•	
Un botón de control multifuncional para regular el volumen y la ganancia de entrada, y un •	
control MIDI asignable
Indicadores LED multi-segmento para mostrar los niveles de entrada o salida•	
FireWire 400, compatible con Mac OS X Core Audio•	
Integración y control con GarageBand, Logic Pro, Logic Express  •	
y Final Cut Studio (Soundtrack Pro)
Compatible con todas las aplicaciones de audio compatibles con Core Audio•	
Software Maestro de Apogee para un control avanzado y una mezcla de baja latencia•	

 
Requisitos del sistema

Sistema: Mac G4 1GHz o superior, PPC o Intel CPU  
Memoria: 1 GB RAM mínimo, 2 GB recomendado
OS X: 10.4.11 o superior instalado, 10.5.3 o superior muy recomendado.
Conexión: Puerto FireWire 400



Duet – Manual del usuario

38 Notificaciones 

Notificaciones

Registro del propietario

El número de serie está situado en el panel posterior de la unidad. Se recomienda anotar el número de 
serie en el espacio provisto para ello. Mencione este número cada vez que contacte con el fabricante o 
con un técnico autorizado de Apogee Electronics. ¡No olvide devolver la garantía tras rellenar todos los 
datos!

Nº serie  Duet________________________________________________________________________

Fecha de compra____________________________________________________________________
 
Distribuidor__________________________________________________________________________

Teléfono____________________________________________________________________________

Dirección___________________________________________________________________________

ATENCIÓN:
Cualquier	cambio	o	modificación	sin	aprobación	expresa	de	APOGEE	ELECTRONICS	CORPORATION	 
podría anular su derecho a utilizar este equipo en cumplimiento con lo dispuesto por la legislación FCC.

Registre su unidad rellenando el formulario incluido o a través de la web visitando

http://www.apogeedigital.com/register/ 

Avisos

Aviso FCC
Este dispositivo es conforme con los límites establecidos por la Clase B para aparatos digitales, según 
lo estipulado en la Parte 15 de las normas FCC. Estos límites han sido establecidos para ofrecer una 
protección razonable contra interferencias no deseables en entornos comerciales. Esta unidad genera, 
usa y puede transmitir señales de radiofrecuencia y, si no se instala y utiliza de conformidad con las 
instrucciones de este manual, puede provocar interferencias no deseables en las radiocomunicaciones. 
El uso de este equipo en una zona residencial puede provocar interferencias perjudiciales, en cuyo caso 
el usuario deberá adoptar por su cuenta las medidas necesarias para evitar esas interferencias.

Aviso de copyright

Apogee Ensemble es un dispositivo basado en ordenador y contiene y utiliza software en ROMs. Este 
software y toda su documentación asociada, incluyendo este Manual del usuario, contiene información 
propiedad de Apogee protegida por leyes de copyright. Reservados todos los derechos. No es posible 
copiar,	transferir	o	modificar	ninguna	parte	del	software	o	de	su	documentación	asociada.	No	es	
posible	modificar,	adaptar,	traducir,	ceder,	distribuir,	vender	o	crear	obras	derivadas	del	software	o	de	
su documentación asociada (o de cualquiera de sus partes) sin el consentimiento escrito de Apogee 
Electronics Corporation, U.S.A.
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Registro e Información de garantía

Asegúrese de registrar su unidad Duet rellenando la tarjeta de registro incluida o completando el 
formulario de registro on-line publicado en nuestra página web: http://www.apogeedigital.com/support/. 
Una vez efectuado el registro, Apogee podrá contactar con usted para ofrecerle cualquier información de 
actualización.	Apogee	contactará	con	usted	a	través	de	la	dirección	especificada	en	el	registro	a	medida	
que	se	vayan	desarrollando	ampliaciones	o	actualizaciones.	Las	actualizaciones	de	firmware	son	gratuitas	
durante	el	primer	año	de	propiedad	del	producto	a	menos	que	se	especifique	lo	contrario.	Por	favor,	si	tiene	
alguna duda póngase en contacto con su distribuidor o directamente con Apogee:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA  90404, USA. 
Tel: (310) 584-9394
Fax: (310) 584-9385
E-mail: support@apogeedigital.com 
Web: http://www.apogeedigital.com

APOGEE ELECTRONICS CORPORATION garantiza este producto ante defectos materiales y de 
fabricación en condiciones normales de uso durante un periodo de 12 meses. El plazo de esta garantía 
empieza el día de la venta al comprador. Las unidades devueltas para reparación a Apogee o a un 
proveedor de servicios autorizado por Apogee serán reparadas o reemplazadas a discreción del fabricante 
sin coste para el usuario. 
TODOS LOS ENVÍOS DE UNIDADES DEVUELTAS A APOGEE O A UN PROVEEDOR DE SERVICIOS DE 
REPARACIÓN AUTORIZADO POR APOGEE DEBEN SER PREVIAMENTE PAGADOS, ASEGURADOS 
Y ADECUADAMENTE EMPAQUETADOS, PREFERIBLEMENTE, EN SU CAJA ORIGINAL. Apogee se 
reserva	el	derecho	a	modificar	o	mejorar	el	diseño	en	cualquier	momento	y	sin	notificación	previa.	Los	
cambios de diseño no se implementan de forma retroactiva, y la incorporación de cambios de diseño en 
unidades futuras no implica la disponibilidad de actualizaciones para las unidades existentes.

Esta garantía queda anulada si Apogee determina, a su entera discreción, que el defecto del producto es 
resultado del mal uso, negligencia, alteración o una reparación realizada por personal no autorizado. 

Las	garantías	especificadas	en	este	documento	sustituyen	a	cualquier	otra	garantía	expresa	o	
implícita,	y	Apogee	queda	específicamente	libre	de	responsabilidad	ante	cualquier	garantía	implícita	de	
comercialización o adaptación a un propósito particular. El comprador comprende y acepta que Apogee en 
ningún caso será responsable de ningún daño especial, indirecto, incidental o derivado, ni de  cualquier 
lesión o daño sufrido por una persona o propiedad que pueda ser resultado de un funcionamiento 
incorrecto de este equipo en cualquier momento. 

EEUU: Algunos estados prohíben la exclusión o limitación de garantías implícitas o de la responsabilidad 
ante	daños	incidentales	o	derivados,	de	manera	que	la	exclusión	especificada	más	arriba	puede	no	ser	
aplicable	al	usuario.	Esta	garantía	le	otorga	derechos	legales	específicos,	y	es	posible	que	disponga	de	
otros derechos que pueden variar entre estados. 

Información de servicio

Duet	contiene	componentes	no	manipulables	por	el	usuario:	acuda	a	personal	cualificado	para	llevar	a	cabo	
las reparaciones o actualizaciones. La garantía quedará anulada si el usuario manipula los componentes 
internos. Si tiene alguna duda respecto a esta consideración, por favor póngase en contacto con Apogee. 

En el caso de que su unidad Duet deba ser actualizada o reparada, póngase en contacto con Apogee antes 
de enviar la unidad para que le sea asignado un número de autorización de devolución de material (Return 
Materials Authorization - RMA). Este número le servirá de referencia y facilitará el proceso de devolución. 
Apogee exige que los envíos sean asegurados y pagados previamente a menos que se indique lo contrario 
por adelantado. 

IMPORTANTE: NO SE ACEPTARÁ NINGÚN ENVÍO QUE NO HAYA SIDO PAGADO PREVIAMENTE O 
QUE NO TENGA UN NÚMERO RMA ASIGNADO. 
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Declaración de conformidad

Este dispositivo es conforme a lo estipulado en la Parte 15 de las normas FCC. El funcionamiento está 
sujeto a las siguientes condiciones: 
1. Este dispositivo no puede causar interferencias perjudiciales
2.  Este dispositivo debe aceptar cualquier interferencia recibida, incluyendo las interferencias que puedan 

provocar un funcionamiento indeseado.

Este dispositivo es conforme con los límites establecidos por la Clase A para aparatos digitales, según 
lo estipulado en la Parte 15 de las normas FCC. Estos límites han sido establecidos para ofrecer una 
protección razonable contra interferencias no deseables en instalaciones domésticas. Esta unidad genera, 
usa y puede transmitir señales de radiofrecuencia y, si no se instala y utiliza de conformidad con las 
instrucciones de este manual, puede provocar interferencias no deseables en las radiocomunicaciones. Si 
la unidad provoca interferencias en la recepción de radio o televisión, lo cual podrá comprobar conectando 
y desconectando la unidad, intente reducir la interferencia aplicando alguna de las medidas siguientes:

1.  Reoriente o cambie la ubicación de la antena receptora.
2.  Aumente la separación entre la unidad y el receptor.
3.  Conecte la unidad y el receptor en tomas eléctricas diferentes, de modo que ambos utilicen circuitos 

eléctricos distintos.
4.  Consulte con su proveedor o técnico especializado en radio/TV.

NOTA: Esta prohibido e uso de un cable no protegido con este equipo.
ATENCIÓN:	Los	cambios	o	modificaciones	no	aprobados	de	forma	expresa	por	el	fabricante	responsable	
del cumplimiento de las condiciones de uso pueden anular la autoridad del usuario para utilizar el equipo.

Apogee Electronics Corporation, Betty Bennett, CEO.

Industry Canada Notice

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matérial brouilleur du Canada.

Declaración de conformidad – CE

Apogee	Electronics	Corporation	declara	por	la	presente	que	el	producto	Duet,	al	que	se	refiere	esta	
declaración,	cumple	las	condiciones	materiales	especificadas	por	los	siguientes	estándares	o	documentos	
normativos:

 EN55022:1998, EN55024:1998 
 
 EN61000-3-2, EN61000-3-3, EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5, EN61000-4-6, 

EN61000-4-8, EN61000-4-11

Declaración de conformidad – Japón

Apogee	Electronics	Corporation	declara	por	la	presente	que	el	producto	Duet,	al	que	se	refiere	esta	
declaración, cumple las condiciones materiales del estándar VCCI Clase B.

Declaración de conformidad – Australia/New Zealand

Apogee Electronics Corporation declara por la presente que el producto Duet cumple las condiciones 
materiales del estándar AN/NZS. 
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